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1. System configuration

This driver is the “Serial Master Driver” among the "MODBUS Protocol” of “"MODBUS Organization”.

Depending on the external device (MODBUS Slave Protocol supported), you may set the “command code”, “protocol frame format”
etc., of the driver separately. In this case, set the detailed settings according to the external device side based on the communication
method.

The system configuration with an external device supported by this driver is as follows:

Series CPU Link I/F Communication method System setting Cable
RS-232C
3. TOP communication
setting
MODBUS Slave Device RS-422 (4 wire) 5. Cable table

4. External device

setting

RS-485 (2 wire)

W Connectable configuration

+ 1:1 (one TOP and one external device) connection — configuration which is possible in RS232C/422/485 communication.

+ 1:N (one TOP and multiple external devices) connection — configuration which is possible in RS422/485 communication.
P .0 S—

{J moj | ;'_34-?] .........
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2. External device selection

H Select a TOP model and a port, and then select an external device.

Select Device H
PLC select [COM1]

Filter : |[AII] v‘ Search : I:I

@ Model (O Vendor

Vendor

Rodkwell Automation L

Schneider MODBUS Master Seri

GE Fanuc Automation & UNLTELWAY

PANASONIC Electric Works

YASKAWA Electric Corporation
YOKOGAWA Electric Corporation
KDT Systems

RS Automation

HITACHI IES

FATEK Automation Corporation
DELTA Electronics

KOYO Electronic Industries

VIGOR Electric Corporation

COMFTIF TECHNOI OGY Tnc &

4_Back | B Next *® Cancel

Select Device n

PLC Setting[ Schneider MODBUS Master Series ]

Alizs Mame @ |PLCL

Interface : | Serial ~

Protocol : | MODBUS RTU ~ Comm Manual
String Save Mode : |First LH HL Change

[ use Redundancy

Primary Option

Timeout msec «
Send Wait m msec
Slave Equipment Address No m
Address Mode

[0 Device Option]

Start Address 0 =

End Address 55534 &

Read Boundary 2000 =

Write Function Fuinction Mvnf | M

@ Back + OK * Cancel
Settings Contents

TOP Model Check the TOP display and process to select the touch model.
External device | Vendor Select the vendor of the external device to be connected to TOP.

Select “Schneider Electric Industries”.

PLC Select an external device to connect to TOP.

‘ Interface Protocol
Schneider MODBUS Master Series Serial Set Users

Supported Protocol
MODBUS RTU ‘ MODBUS ASCII

Please check the system configuration in Chapter 1 to see if the external device you want to

connect is a model whose system can be configured.
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The communication can be set in TOP Design Studio or TOP main menu. The communication should be set in the same way as that

of the external device.

3.1 Communication setting in TOP Design Studio

(1) Communication interface setting

M [Project > Project Property > TOP Setting] — [Project Option > “Use HMI Setup” Check > Edit > Serial]

— Set the TOP communication interface in TOP Design Studio.

Project Option

- Crange HMIH] | | Add PLC 1] TR change PLCICl | [ Delete PLCIDI
pr—

Global Lock & Touch Project Style

Splash

PLC Buffer Sync.

Initialization

Edit

t- TOP Sett I
D= €ting 0% Date / Time Sync. Screen Option Unit Convert
~ # Option Module Setting Project Option ~ Screen Change || HmiSetup

-4 FieldBus (0)

-4 RFID (0) Use HMI Setup
~ -ig Device Setting

v g8 COM1 (1) SRR

- PLC1: Schneider MODBUS Project Setting

--13% COM2 (0)
L.rg8 COM3 (0)
Ethernet {0)
Wireless (0)

i -4 USBDevice (0)

Latch Use=0

HMIDisable=0

Project Mame=Mew project
Start Mode=Menu

Start Screen No.=1

Latch Set=0~0
Communication Error Message=0
USBErrorMessage =0

Control Panel

System m Devices

.—a Service _4'"'_' Option

o Serial >
[F———
1| - 0 : :
Serial Port: | COMI =
PLC ot it Dat e /Ti .
ecurity =t 24T ime Signal Level
(®) RS-232C () Rs-422(4) O Rs-485(2)
""I" ! o o ' Baud Rai.:e- 38400 ~
Data Bit: & ~
Et hernet Serial HOK | .
Stop Bit: |1 -
— Parity Bit: None M
| &= N
i () A Flow: (ff
Diagnost ic MF”E Ring Auto Search | Loopback Test
anager
Apply | Cancel
Items TOP External device Remarks
] RS-232C RS-232C
Signal Level (port)
RS-422/485 RS-422/485
Baud Rate 38400
Data Bit 8
Stop Bit 1
Parity Bit None.

* The above settings are examples recommended by the company.

Items Description

Signal Level Select the serial communication method between the TOP and an external device.

Baud Rate Select the serial communication speed between the TOP and an external device.

Data Bit Select the serial communication data bit between the TOP and an external device.

Stop Bit Select the serial communication stop bit between the TOP and an external device.

Parity Bit Select the serial communication parity bit check method between the TOP and an external device.
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(2) Communication option setting
M [Project > Project Property > Device Setting > COM > “PLC1 : Schneider MODBUS Master Series”]

— Set the options of the Schneider MODBUS Serial Master communication driver in TOP Design Studio.

TO,
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Project Option X
- Change HMI[H] “ AddPLC Al | T} ChangePiCicl [ Delete PLC[D)
* L3 TOP Setting PLC Setting[ Schneider MODBUS Master Series ]
3 5Y5 : RD1520X
~ -l Option Module Setting Alins Name :
i W Fieldbus (0) Interface : | Serial ~
W RFID (0)
4 Device Setting Protocol : MODBUS RTU ~ Comm Manual
String Save Mode : |First LH HL Change
A® PLC1 : Schneider MODBUE|
,:, com3 (o) [] use Redundancy
..g# Ethernet (0) AND ~
g Wireless (0) - =
8 USBDevice (0) hd I
Primary Option
Timeout 200 < | msec "
Send Wait _ msec
Slave Equipment Address No _
Address Mode
[0 Device Option]
Start Address o B
End Address 65534 =
Read Boundary w0 =
Wirite Function Function 0x0f
Wirite Boundary 800 B
[1 Device Option]
Start Address o B
End Address 65534 =
Read Boundary w0 =
[3 Device Option]
< > Start Address n a w
Apply Close
Items Settings Remarks
Interface Select “Serial". Refer to “2. External
Protocol Select the communication protocol between the TOP and an external device. device selection”.

TimeOut (ms)

Set the time for the TOP to wait for a response from an external device.

SendWait (ms)

Set the waiting time between TOP's receiving a response from an external device and

sending the next command request.

Slave Equipment
Address No

Enter the prefix number of an external device (Slave).

Address Mode

Select the Address Mode. (1-base: "address-1" operation/0-base: no operation)

[0 Device Option]

Start Address

Enter the Start Address of the Coil.

End Address

Enter the End Address of the Coil.

Read Boundary

Set the maximum number of consecutive reads for the Coil.

Write Function

Set the write command for the Coil.
Force Single Coil : 05(Hex) / Force Multiple Coils : OFHex)

Write Boundary

Set the maximum number of consecutive writes for the Coil.

[1 Device Option]

Start Address

Enter the Start Address of the Discrete Input.

End Address

Enter the End Address of the Discrete Input.

Read Boundary

Set the maximum number of consecutive reads for the Discrete Input.

[3 Device Option]

Start Address

Enter the Start Address of the Input Register.

End Address

Enter the End Address of the Input Register.

Read Boundary

Set the maximum number of consecutive reads for the Input Register.

[4 Device Option]

Start Address

Enter the Start Address of the Holding Register.

End Address

Enter the End Address of the Holding Register.

Read Boundary

Set the maximum number of consecutive reads for the Holding Register.

Write Function

Set the write command for the Holding Register.

Preset Single Register : 06(Hex) / Preset Multiple Registers : 10(Hex)

Write Boundary

Set the maximum number of consecutive writes for the Holding Register.
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3.2. Communication setting in TOP

TO,

ERI2 e B X
Touch Qperation Panel

* This is a setting method when “Use HMI Setup” in the setting items in “3.1 TOP Design Studio” is not checked.

W Touch the top of the TOP screen and drag it down. Touch “EXIT" in the pop-up window to go to the main screen.

(1) Communication interface setting

M [Main Screen > Control Panel > Serial]

Run

5

Conitkroll Panel

O | 0 T

Serial Port: l[][]rm ‘v]
!Illl Signal Level
PLC Secur ity ® PS-232C (O BS-4z22(4) O RsS-485(2) ]
Baud Rate: | 38400 ~|
YHC
erer ] [ 2 Data Bit: |8 -
:ﬁ Ethernet Serial Stop Bit: l 1 ‘v]
[l g aMLo
== Parity Bit: lNOﬂe "l
5 = Flow: | [ff -
il = | i
Diagnast ic File lAuto Searchl [Loopback Test]
Manager
f [ Apply H Cancel ] —
[System] CTose r
el
Items TOP External device Remarks
RS-232C RS-232C
Signal Level (port)
RS-422/485 RS-422/485
Baud Rate 38400
Data Bit 8
Stop Bit 1
Parity Bit None.

* The above settings are setting

examples recommended by the company.

Items Description

Signal Level Select the serial communication method between the TOP and an external device.

Baud Rate Select the serial communication speed between the TOP and an external device.

Data Bit Select the serial communication data bit between the TOP and an external device.

Stop Bit Select the serial communication stop bit between the TOP and an external device.

Parity Bit Select the serial communication parity bit check method between the TOP and an external device.
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(2) Communication option setting

M [Main Screen > Control Panel > PLC]

70 PLC
Or i ver (COM1) ‘ PLC1(Schneider MODBUS Master Series) v]
Interface | Serial v -
al,l|| Protocol | MODBUS RTU B
PLC Timeout 300 [ msec
.l"": Send Wait Msec
e I T B s .
FEEg ] L
] ﬁ Et hernet Slave Ea _ﬂ
. Address b 0-Bas |~
Emmd
Screen " [0 Device
shot o | startade [0 2
Diagnostic | End Addre B5534 |3
Read Bour 2000 2
Write Fur ~|
il
[Systerql Diagnostic ] [ Aep |y HCancel l

el

Items Settings Remarks

Interface Select “Serial". Refer to "2. External
Protocol Select the communication protocol between the TOP and an external device. device selection”.
TimeOut (ms) Set the time for the TOP to wait for a response from an external device.

SendWait (ms) Set the waiting time between TOP’s receiving a response from an external
endWait (ms
device and sending the next command request.

Slave Equipment Address No | Enter the prefix number of an external device (Slave).
Address Mode Select the Address Mode. (1-base: "address-1" operation/0-base: no

operation)

[0 Device Option]

Start Address Enter the Start Address of the Coil.
End Address Enter the End Address of the Coil.
Read Boundary Set the maximum number of consecutive reads for the Coil.

Set the write command for the Coil.
Force Single Coil : 05(Hex) / Force Multiple Coils : OF(Hex)

Write Boundary Set the maximum number of consecutive writes for the Coil.

Write Function

[1 Device Option]

Start Address Enter the Start Address of the Discrete Input.
End Address Enter the End Address of the Discrete Input.
Read Boundary Set the maximum number of consecutive reads for the Discrete Input.

[3 Device Option]

Start Address Enter the Start Address of the Input Register.

End Address Enter the End Address of the Input Register.

Read Boundary Set the maximum number of consecutive reads for the Input Register.
[4 Device Option]

Start Address Enter the Start Address of the Holding Register.

End Address Enter the End Address of the Holding Register.

Read Boundary Set the maximum number of consecutive reads for the Holding Register.

. . Set the write command for the Holding Register.
Write Function

Preset Single Register : 06(Hex) / Preset Multiple Registers : 10(Hex)
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Write Boundary ‘ Set the maximum number of consecutive writes for the Holding Register. ‘

3.3 Communication diagnostics

M Check the interface setting status between the TOP and external device.
- Touch the top of the TOP screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen.
- Check if the COM port settings you want to use in [Control Panel > Serial] are the same as those of the external device.

W Diagnosis of whether the port communication is normal or not
- Touch “Communication diagnostics” in [Control Panel > PLC].

- The Diagnostics dialog box pops up on the screen and determines the diagnostic status.

oK Communication setting normal

Time Out Error Communication setting abnormal

- Check the cable, TOP, and external device setting status. (Reference: Communication diagnostics sheet)

B Communication diagnostics sheet

- If there is a problem with the communication connection with an external terminal, please check the settings in the sheet below.

Items Contents Check Remarks
System How to connect the system OK NG ) )
' . ) 1. System configuration
configuration Connection cable name oK NG
TOP Version information oK NG
Port in use OK NG
Driver name OK NG
Other detailed settings oK NG
Relative prefix Project setting oK NG
Communication 2. External device selection
. . oK NG . i
diagnostics 3. Communication setting
Serial Parameter Transmission
oK NG
Speed
Data Bit oK NG
Stop Bit oK NG
Parity Bit oK NG
External device CPU name oK NG
Communication port name (module name) OK NG
Protocol (mode) OK NG
Setup Prefix oK NG
Other detailed settings OK NG . .
4. External device setting
Serial Parameter Transmission
oK NG
Speed
Data Bit oK NG
Stop Bit oK NG
Parity Bit oK NG
Check address range 6. Supported addresses
oK NG (For details, please refer to the PLC
vendor's manual.)
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4. External device setting

Refer to the user manual of the external device to set “"MODBUS Serial Slave Driver” in the external device I/F.

- Take caution when selecting RTU/ASCII mode in Protocol Frame format.
A - Check the contents of the address map on the external device side and use the communication
address according to its contents.
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5. Cable table

This chapter introduces a cable diagram for normal communication between the TOP and the corresponding device.

(The cable diagrams described in this section may differ from the external device vendor’s recommendations.)

W RS-232C (1:1 connection)

TOP External device
Pin Signal Pin Cable connection Signal
arrangement*Note 1) name number name
1 5 CcDh 1
g S‘ sD 3 RD
Based on DTR 4 T— DTR
communication SG 5 l_ 5G
cable connector DSR 6 DSR
front, RTS 7 E RTS
D-SUB 9 Pin male cTs 8 cTs
(male, convex) 9

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector.

W RS-422 (1:1 connection)
TOP External device
Pin Signal Pin Cable connection Signal
arrangement*Note 1) name number name
1 5 RDA(+) 1 SDA(+)
2 g 3 RDA(+)
Based on RDB(-) 4 RDB(-)
communication SG 5 SG
cable connector SDA(+) 6
front, 7
D-SUB 9 Pin male 8
(male, convex) SDB(-) 9

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector.

W RS-485 (1:1 connection)

TOP External device

Pin Signal Pin Cable connection Signal

arrangement*Note 1) name number RERE

1 5 RDA(+) 1 SDA(+)

2 g 3 *— RDA(+)

Based on RDB() 4 RDB(-)

communication SG 5 SG

cable connector SDA(+) 6
front, 7
D-SUB 9 Pin male 8
(male, convex) SDB(-) 9

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector.

== Continued on next page.
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M RS-485 (1:1 connection)
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TOP External device
. Signal Cable connection Signal
Pin arrangement

name name

O + SDA(+)

- SDB(-)

|  SG Ne RDA(+)

| = RDB()
1@l + SG

W RS-422 (1:N connection) — Refer to 1:1 connection to connect in the following way.

TOP

Signal name

RDA(+

RDB(-)
SDA(+)

SDB(-)
SG

)

Cable connection and signal direction

External device Cable connection and signal External device
Signal name direction Signal name
SDA(+) SDA(+)
SDB(-) SDB(-)
RDA(+) RDA(+)
RDB(-) RDB(-)

SG SG

B RS-485 (1:N/N:1 connection) — Refer to 1:1 connection to connect in the following way.

TOP

Signal name

RDA(+)
RDB(-)
SDA(+)
SDB(-)
SG

Cable connection and signal direction

External device

Cable connection and signal External device

Signal name direction Signal name
SDA(+) - SDA(+)
SDB(-) J SDB(-)
RDA(+) RDA(+)
RDB(-) T RDB(-)

SG SG
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6. Supported addresses
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The devices available in TOP are as follows:

The device range (address) may differ depending on the CPU module series/type. The TOP series supports the maximum address
range used by the external device series. Please refer to each CPU module user manual and be take caution to not deviate from the
address range supported by the device you want to use.

Bit Address Word Address 32 bits Remarks
Coll Q00001 — Q065536 Q00001 — Q65521
Discrete Input 100001 — 165536 100001 — 165521 U *Note 1)
Input Register IW00001.00 — IW65536.15 IW00001 - IW65536 *Note 1)
Holding Register MWO00001.00 - MW65536.15 MWO00001 — MW65536

*Note 1) Cannot be written (Read-only)

External device connection manual for TOP Design Studio
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Appendix A. Standard MODBUS Protocol

Describes MODBUS protocol commands and devices supported by “MODBUS Serial Master Driver” of this device.

At the message level, the MODBUS protocol still applies the master—slave principle even though the network communication
method is peer—to—peer. If a controller originates a message, it does so as a master device, and expects a response from a slave

device. Similarly, when a controller receives a message it constructs a slave response and returns it to the originating controller.

Cuery message from Master

Device Addrass Device Address
Function Code Function Code
Eight-Bit | | Eight-Bit
— Data Bytes — — Data Bytes —
Error Check Error Check

Response message from Slave

The Query: The function code in the query tells the addressed slave device what kind of action to perform. The data bytes contain
any additional information that the slave will need to perform the function. For example, function code 03 will query the slave to
read holding registers and respond with their contents. The data field must contain the information telling the slave which register
to start at and how many registers to read. The error check field provides a method for the slave to validate the integrity of the
message contents.

The Response: If the slave makes a normal response, the function code in the response is an echo of the function code in the query.
The data bytes contain the data collected by the slave, such as register values or status. If an error occurs, the function code is
modified to indicate that the response is an error response, and the data bytes contain a code that describes the error. The error

check field allows the master to confirm that the message contents are valid.
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Read Single Coil : 01

Describes “01" command frame through the example where “000020-000056 Coil” data of the Slave device side (prefix: 17) is read
from the MASTER device.

W RTU Mode
(Master > Slave: request frame)
0O (%) Q) — o (@)
3 . 3 =3 © ~
s 3 |2 | @ 2 g
ER e |8
< e
: E
H L |H L | L H
Hex |11 |01 00| 13|00 25| —|— B Coils data status
(Slave > Master: response frame) Coils | 27 | 26 [ 25 | 24 | 23 [ 22 | 21 | 20
A - N > N on/off 1 1 0 0 1 1 0 1
212 |3 |3 (Data ) 2 Coils | 35|34 |33]32|31]30]29] 28
2l=s |3 |8 a onjoff | 0 | 1| 1o 1o 1]
= o, 3 Q. 0 0 I ) I 3
E 2|2 |88 8|8 S Coils | 43 | 42 | 41 [ 40|39 38]37]36
8IS |w | n o | o ) onfoff | 1 [ o[ 1|1 |lo]o]|1]o0
g |3 |© |2 | &R o
2 |o |= s | x| Coils | 51 | 50 | 49 | 48 | 47 | 46 | 45 | 44
- onfoff | 0 o | oo | 1]1]1]o0
L - - - H| L H :
Coils | 59 | 58 | 57 | 56 | 55 | 54 | 53 | 52
Hex |11 |01 |05 |co|eB|B2]oE|1B|—|— ongoff | - | - | - | 10100l
0: OFF / 1:O0N
W ASCIl Mode
(Master > Slave: request frame)
8 | & g e ) g Q g
3 @ < 3 o <. @
3 |3 : 3 5 B ~
® = ° o @ " a
= ® =} a A o
= (o o o
= ‘<D 3 )
g o
8
H L|lH L|H - - Ll|lHw - = Ll L H
ASCII 1 1 0 1 0 0 1 3 0 0 2 5 CR LF
Hex | 3A |31 ]31]30|31 303031 ]33]|30]|30][32]|3]—|—|o]oa
(Slave > Master: response frame)
I T [%) ) T z o) =
S e 3 S | %5 pata g .
2% | = 8 “ 8 3
=} 0] 3 o
- = o [a) [a) [a) [a) [a) o
= o o o o o o
9. & & & & & =
~ wui w — o @)
a o 0 hY IS & =
Q o © [e)) IS [\
&
H L|H L|H L|lH L|H L] H
ASCII 1 1 0 1 0 5 C D 6 B B 2 0 E 1 B CR LF
Hex | 3A| 31|31 30|31 30| 35] 43| 44|36 |42|42|32]30 |45 |31][42]—|—|oD]oa
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Force Single Coil : 05
Describes “05” command frame through an example where FORCE "“ON" is done on Coil 000173 of the Slave device side in the MASTER

device.
H RTU Mode
(Master > Slave: request frame) /\»
/ W Force Data
e g & o g Q High  Low
3 |5 |3 o a 2
3 .| 3 3 a ~ Force ON FFy 00y
2 ol 3 a & S
;—2 o ) B % Force OFF 004 00y
<
) 3
o

H L H L L H
Hex | 11| 05 | 00 | Ac | FF |00 | —

(Slave > Master: response frame

N

JuUsWIWOD)

xiy24d ane|s
puewwod

921nap Bulpea
elep 92404

(D¥D) 8pod HayDd

H L H L L H
Hex | 11| 05 |00 | Ac | FF |00 | — | —

H ASCIl Mode
(Master - Slave: request frame)
8 |z | ¢ 9 5 g o Sy
@® = ° D Q o a
2 g 2 o & 4
2 2. Q B
- -
8
H oL |H L|lH - - L|lH - - Ll L H
asci | : 1 1o s{o o 1 3|0 0o 2 s CR LF
Hex |3 [ 31313031 |30 |30 |41 ]43]45]45]30]30|—|—|op]oa
(Slave - Master: response frame)
3 |3 5 3 5 e ~
S| 3 E = & 8
2 5 3 5 5 8
B [
8
H L H L H - - L H - - L L H
asci | : 1 1o s|o o 1 3|0 0o 2 5 CR LF
Hex | 3A |31 ] 313031 |30 30|41 ]43]45]45]30]30] —|—|op]oa
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A.2 “1" Device (Discrete Input)

Read Input Status : 02
Describes “"02" command frame through an example where “100197-100218 Input” data of the Slave device side (prefix: 17) is read
from the MASTER device.

M RTU Mode
(Master > Slave: request frame)

JUBWIWOD
xiya1d anels
puewwod
221A9p Bulpea
21025 ad1n8Qg

(0¥D) 8pod HaYd

H L H L L H
Hex |11 |02 | 00| caloo|6] —|—

(Slave - Master: response frame) — » W Coils data status
Alw |o |z A Coils | 204 | 203 | 202 | 201 | 200 | 199 | 198 | 197
9 o c Data (Inputs) 3
25 |2 |2 8 on/off | 1 o | 1 0| 1 1 0| o
g ('i s ST R I 8 Coils | 212 | 211 | 210 | 209 | 208 | 207 | 206 | 205
x o IS |8 |R 2 onfoff | 1 | 1 | o | 1 | 1 o | 1|1
T E e E 2 Coils | 220 | 219 | 218 | 217 | 216 | 215 | 214 | 213
a |35 |8 |2 onfoff | - | - | 1 | 1 | o | 1| o | 1
® 0: OFF / 1:0N
L H
Hex 11 102 |03 |AC|DB|35 | — | —
W ASCIl Mode
(Master > Slave: request frame)
s |7 | ¢ 2 ] ? z Z
3 @ < 3 o <. @
3 |3 : 3 5 B ~
@ = ° @ Q@ " a
> g, 2 a 8 3
=3 ?<D % )
d :
8]
H L|H L|lH - - L]|H - - Ll L H
ASClI : 1 1 0 2 0 0 C 4 0 0 1 6 CR LF
Hex | 3A |31 )31 3032|3030 |43]34]30]30]31]36|—|—|op]oa
(Slave > Master: response frame)
) T %) ) z 0 o
g 3 2 < Data (Inputs) 2 =
3 Q. @ 3 3 Q
3 |2 o 5 g N
2 o8 3 - - N 9
o 5 R R 2
I N o © o
& N e he A
—~ o o o ~
O — N E
?m,; N ] »
H L |H L|H L|L H
ASClI : 1 1 0 2 0 3 A C D B 3 5 CR LF
Hex | 3A 31|31 30|31 [3035|41]43|44]42|33|35|—|—|op]oa
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A3 “3" Device (Input Register)

Read Input Registers : 04

Describes “03" command frame through an example where “300009 Register” data of the Slave device side (prefix: 17) is read from
the MASTER device.

M RTU Mode

(Master > Slave: request frame)

JUBWIWOD
xiya1d anels
puewwod
221A9p Bulpea
(qunod piomw)
21025 ad1n8Qg

(0¥D) 8pod HaYd

H L H L L H
Hex |11 |04 | 00| 08|00 |01 | —|—

(Slave > Master: response frame)

ACRERE o
3 % 3 5 Data 2
= o, a Q. w o o
* g | 8¢ 2
& ) % 9
Il = 5)
g 3
B
H L L H
Hex |11 |04 |02 00 |oa| — | —
W ASCIl Mode
(Master > Slave: request frame)
s |7 | ¢ 2 ] B z Z
3 [ < 3 o o < o
3 |3 : 3 5 a3 ~
@ = o o) Q a
E g, 2 = g
< (<D o)
3 . =
8 3
[0}
Ho oL |wH L|lH - - L|lw - - Ll L H
ASCII 1 110 1]/0 o o 8lo o o 1 CR LF
Hex | 3A |31 ]31 3031|3030 |30 |38|30]30][3]|3]—|—|o]oa
(Slave > Master: response frame)
I T %) I s z o) =
S 18] 3 S |35 Data z .
2 |° T 5 ] 2
? 2 2 57 &
=3 S g £
[e3) @ 6
o
oy
QO
H - L L H
asci | : |1 1 lo 4|0 2|0 oo A CR LF
Hex | 3A| 31|31 30|31 |30 |35]30[30[30]|41]|—|—|op]|oa
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A4 “4" Device (Holding Register)

TD BT UE E WY
Touch Operation Panel

Read Holding Registers : 03

Describes “03" command frame through an example where “400108 — 400110 Register” data of the Slave device side (prefix: 17) is read

from the MASTER device.

M RTU Mode
(Master > Slave: request frame)
g 1g |9 ) 5 Q
3 |5 |32 = & 3
3 . 3 5 © ~
S |5 |5 < 2 3
A - 3 3
8 [
(e}
H L | H L L H
Hex | 11|03 | 00|68 |00 03] —]|—
(Slave > Master: response frame)
e |lg |8 | & Q
3 é 3 g_ Data ’3
: |3 |2 |8 A
12t Eeg |gg |ag | B
2 o & o &H = & ’a
Pl ®8 © 8 ° 3 =
(on = = = @)
g b
3
H L | H L | H L L H
Hex | 11| 03 | 06 | 02 | 28 | 00 | 00 | 00 |64 | — | —
Hl ASCIl Mode
(Master > Slave: request frame)
aQ T %) [} e = O [@) o
Slg | = g 2 52 2 =
3 | & i 3 5 g3 ~
S| 3 E = 8
2 g 3 5 g
s « =
8 5
[0}
H L | H L | H - - L | H - - Ll L H
ASClI : 1 1 0 1 0 0 1 3 0 0 2 5 CR LF
Hex | 3A |31 ] 313031 |30|30]31]33]30[30]32]3]|—]—|op]oa
(Slave - Master: response frame)
g 2 ) g § £ Data % §'_:
|| 2 g 3 2
%] 3 2 =8 5
- = & 57 57 57 &
) < s S =5 -
N o o o) 3
)
Q
H - L | H - L H - L L H
ASCII : 1 1 0 3 0 6 0 2 2 B 0 0 0 0 0 0 6 4 CR LF
Hex | 3a |31 |31 30|31 3035|3032 |32]42|30|30|30]|30][30]30]|36]|34|—|—]o]oa
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TO BRI HE B X
Touch Qperation Panel
Preset Single Register : 06 ‘

Describes “06" command frame through an example where 00 03 (hex) data is entered in 400002 Register of the Slave device side .

H RTU Mode
(Master > Slave: request frame)

JUBWIWOD)

xiy24d ane|s
puewwod
2o1A9p Buipea
ejep j9sald

(O¥D) apod ¥3YD

H L H L L H
Hex | 11 |06 | 00 | 01| 00| 03 | —

(Slave > Master: response frame

N

cle (o | & 3 o
@ wv
2|2 |3 s 8 2
2 |13 |5 < g 3
N 5 §
? 2
H L H L L H
Hex | 1106 | 00| 01|00 03] —]—
B ASCIl Mode
(Master > Slave: request frame)
3 o> ® 3 5 ol *
o] = ° ) Q@ [oR Q
2 i 2 aQ 9 g
3 (SD, 1Y @
- -
8
Ho oL |H L|lH - - Ll|lH - - Ll L H
asci | |1 1]lo0o 6|0 o o 1]0 0o o0 3 CR LF
Hex | 3A |31 )31 3036|3030 ]30]31]30[30]30]33]—|—op]oa
(Slave - Master: response frame)
3 % ® 3 =3 o ~
S| 3 E S g 8
El 5 g 5 g 8
8 &
3
HoL|wH L|lH - - L|lw - - Ll L H
asci | |1 1]lo0o 6|0 o o 1|0 0o o 3 CR LF
Hex | 3A|31]31]30|36|30]|30|30[31|30]30][30]|33]—|—|o]oa
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TO BRI HE B X
Touch Qperation Panel
Preset Multiple Register : 10 ‘

Describes “10” command frame through an example where two consecutive data, “00 0A (hex)”, “01 02 (hex)" are entered in 400002

Register of the Slave device side. (Error Code : 904)

H RTU Mode
(Master > Slave: request frame)
) [%) ) — = 0 brd o)
o
% % 3 8 g § % Data E
3 |5 |3 5 g 2 3 ~
208 |2 | @ e |7 | 88| 88| ¢
2 9] c 9 S Q S Q =3
< 2 2 Sz —
B =% S 5] 5] @)
Q - - X
by )
@ a
= QO
&
H L H L H L H L L H
Hex |11 |10 | 00| 01| 00| 02|04 |00 0a|01]02]|—]|—
(Slave - Master: response frame)
N v 0 = = e) 0
Sz |5 | & g5 Z
3 |2 |3 5 i 2 ~
@ S o @ o Z a
2 12 |3 o o g
g |ge | &
= 2 —
; & 2
g &
T
H L H L L H
Hex |11 |10 |00 ] 01|00 |o02|—|—

W ASCIl Mode
(Master > Slave: request frame)
aQ T %} 0 [~ = 0O T Z
S8 ¢ S 2 5 5 5 -
3 o - 3 5 o = e T
: 3 : 3 5 S - 57 57
- B o 3 c o g @ g <
<. 370 o o 4 © 4
3 & - 2 2
g g
- Iy
H L|H L|H - - L|H - - |- Ll H - - Ll|H - - L
asct [ ;|1 11 oo o o 1/0 0 o 2|0 4[0 0 0 A|O 1 0 2
Hex | 3a |31 313130303041 |43|30]|30]30]32]30]34]30]30]3]41]30]31 ]3]z

d 2 =
2
3
&
&
G
L H
ASCII CR LF
Hex | — | — |op|oa
(Slave - Master: response frame)
3 | & ° 3 5 3 2 2
o = ° @ Q@ n g a
2 g, 2 5 2 g
= 2 s S ®
5 2= =
o]
H L H L H - - L H - - L L H
asci | 2|1 11 oflo o o 1]0 0 0 2 CR LF
Hex | 3A]31] 313031 |30|30]30]31]30]30]3]32]|—]—|o]oa
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TO BRI HE B X
Touch Qperation Panel

A.5 LRC/CRC Generation

(1) LRC Generation

The Longitudinal Redundancy Check (LRC) field is one byte, containing an 8-bit binary value. The LRC value is calculated by the
transmitting device, which appends the LRC to the message. The receiving device recalculates an LRC during receipt of the message,
and compares the calculated value to the actual value it received in the LRC field. If the two values are not equal, an error results.

The LRC is calculated by adding together successive 8-bit bytes in the message, discarding any carries, and then two's
complementing the result. The LRC is an 8-bit field, therefore each new addition of a character that would result in a value higher
than 255 decimal simply ‘rolls over’ the field's value through zero. Because there is no ninth bit, the carry is discarded automatically.

A procedure for generating an LRC is:

1. Add all bytes in the message, excluding the starting ‘colon’ and ending
CRLF. Add them into an 8-bit field, so that carries will be discarded.
2. Subtract the final field value from FF hex (all 1's), to produce the

ones—complement.

3. Add 1 to produce the twos—complement.

— Placing the LRC into the Message

When the 8-bit LRC (2 ASCII characters) is transmitted in the message, the high-order character will be transmitted first, followed
by the low—order character.

For example, if the LRC value is 61 hex (0110 0001):

colon| Aadr| Func | °®2 | Data| Data| Data| pata| "RC| “FC| cr | LF
Count Hi Lo
& 1

— Example
An example of a C language function performing LRC generation is shown below.

The function takes two arguments:

unsigned char *auchMsg ; // A pointer to the message buffer containing
// binary data to be used for generating the LRC
unsigned short usDatalen ; // The quantity of bytes in the message buffer.

The function returns the LRC as a type unsigned char.

— LRC Generation Function

static unsigned char LRC(auchMsg, usDatalen)

unsigned char *auchMsg ; /* message to calculate LRC upon */
unsigned short usDatalen ; /* quantity of bytes in message */
{
unsigned char uchLRC = 0 ; /* LRC char initialized */
while (usDataLen—) /* pass through message buffer */
uchLRC += *auchMsg++ ; /* add buffer byte without carry */

return ((unsigned char)(=((char)uchLRC))) ; /* return twos complement */
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(2) CRC Generation

The Cyclical Redundancy Check (CRC) field is two bytes, containing a 16-bit binary value. The CRC value is calculated by the
transmitting device, which appends the CRC to the message. The receiving device recalculates a CRC during receipt of the message,
and compares the calculated value to the actual value it received in the CRC field. If the two values are not equal, an error results.

The CRC is started by first preloading a 16-bit register to all 1's. Then a process begins of applying successive 8-bit bytes of the
message to the current contents of the register. Only the eight bits of data in each character are used for generating the CRC. Start
and stop bits, and the parity bit, do not apply to the CRC.

During generation of the CRC, each 8-bit character is exclusive ORed with the register contents. Then the result is shifted in the
direction of the least significant bit (LSB), with a zero filled into the most significant bit (MSB) position. The LSB is extracted and
examined. If the LSB was a 1, the register is then exclusive ORed with a preset, fixed value. If the LSB was a 0, no exclusive OR takes
place.

This process is repeated until eight shifts have been performed. After the last (eighth) shift, the next 8-bit character is exclusive
ORed with the register's current value, and the process repeats for eight more shifts as described above. The final contents of the
register, after all the characters of the message have been applied, is the CRC value.

A procedure for generating a CRC is:

1. Load a 16-bit register with FFFF hex (all 1's). Call this the CRC register.

2. Exclusive OR the first 8-bit byte of the message with the low—order byte of the 16-bit CRC register, putting the result
in the CRC register.

3. Shift the CRC register one bit to the right (toward the LSB), zero—filling the MSB. Extract and examine the LSB.

4. (If the LSB was 0): Repeat Step 3 (another shift). (If the LSB was 1): Exclusive OR the CRC register with the polynomial
value A001 hex (1010 0000 0000 0001).

5. Repeat Steps 3 and 4 until 8 shifts have been performed. When this is done, a complete 8-bit byte will have been
processed.

6. Repeat Steps 2 through 5 for the next 8-bit byte of the message. Continue doing this until all bytes have been
processed.

7. The final contents of the CRC register is the CRC value.

8. When the CRC is placed into the message, its upper and lower bytes must be swapped as described below.

- Placing the CRC into the Message

When the 16-bit CRC (two 8-bit bytes) is transmitted in the message, the low-order byte will be transmitted first, followed by the
high-order byte.

For example, if the CRC value is 1241 hex (0001 0010 0100 0001):

Data CR CE
Addr Func Count Data Data Data Data Clo Chi
4 12

— Example

An example of a C language function performing CRC generation is shown on the following pages. All of the possible CRC values
are preloaded into two arrays, which are simply indexed as the function increments through the message buffer.

One array contains all of the 256 possible CRC values for the high byte of the 16-bit CRC field, and the other array contains all of
the values for the low byte. Indexing the CRC in this way provides faster execution than would be achieved by calculating a new
CRC value with each new character from the message buffer.

Note This function performs the swapping of the high/low CRC bytes internally. The bytes are already swapped in the
CRC value that is returned from the function. Therefore the CRC value returned from the function can be directly placed

into the message for transmission.

The function takes two arguments:

unsigned char *puchMsg ; //A pointer to the message buffer containing
//binary data to be used for generating the CRC
unsigned short usDatalen ; //The quantity of bytes in the message buffer.

The function returns the CRC as a type unsigned short.
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— CRC Generation Function

unsigned short CRC16(puchMsg, usDataLen)

unsigned char *puchMsg ; /* message to calculate CRC upon */

unsigned short usDatalen ; /* quantity of bytes in message */

{
unsigned char uchCRCHi = OxFF ; /* high byte of CRC initialized */
unsigned char uchCRCLo = OxFF ; /* low byte of CRC initialized */
unsigned ulndex ; /* will index into CRC lookup table */
while (usDataLen—) /* pass through message buffer */

{
ulndex = uchCRCHi » *puchMsgg++;  /* calculate the CRC */
uchCRCHi = uchCRCLo ~ auchCRCHi[ulndex} ;
uchCRCLo = auchCRCLo[ulndex] ;

}

return (uchCRCHi << 8 | uchCRCLo) ;

— High-Order Byte Table

/* Table of CRC values for high—-order byte */

static unsigned char auchCRCHi[] = {

0x00, 0xC1, 0x81, 0x40, 0x01, 0xCO, 0x80, 0x41, 0x01, 0xCO, 0x80, 0x41, 0x00, OxC1, 0x81, 0x40, 0x01, 0xCO, 0x80, 0x41,
0x00, 0xC1, 0x81, 0x40, 0x00, OxC1, 0x81, 0x40, 0x01, 0xCO, 0x80, 0x41, 0x01, 0xCO, 0x80, 0x41, 0x00, OxC1, 0x81, 0x40,
0x00, 0xC1, 0x81, 0x40, 0x01, 0xCO, 0x80, 0x41, 0x00, OxC1, 0x81, 0x40, 0x01, 0xCO, 0x80, Ox41, 0x01, 0xCO, 0x80, 0x41,
0x00, 0xC1, 0x81, 0x40, 0x01, 0xCO, 0x80, 0x41, 0x00, OxC1, 0x81, 0x40, 0x00, OxC1, 0x81, 0x40, 0x01, 0xCO, 0x80, 0x41,
0x00, 0xC1, 0x81, 0x40, 0x01, 0xCO, 0x80, 0x41, 0x01, 0xCO, 0x80, 0x41, 0x00, OxC1, 0x81, 0x40, 0x00, OxC1, 0x81, 0x40,
0x01, 0xCO, 0x80, 0x41, 0x01, 0xCO, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xCO, 0x80, 0x41, 0x00, OxC1, 0x81, 0x40,
0x00, 0xC1, 0x81, 0x40, 0x01, 0xCO, 0x80, 0x41, 0x01, 0xCO, 0x80, 0x41, 0x00, OxC1, 0x81, 0x40, 0x00, OxC1, 0x81, 0x40,
0x01, 0xCO, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xCO, 0x80, 0x41, 0x01, 0xCO, 0x80, 0x41, 0x00, OxC1, 0x81, 0x40,
0x00, 0xC1, 0x81, 0x40, 0x01, 0xCO, 0x80, 0x41, 0x01, 0xCO, 0x80, 0x41, 0x00, OxC1, 0x81, 0x40, 0x01, 0xCO, 0x80, 0x41,
0x00, 0xC1, 0x81, 0x40, 0x00, OxC1, 0x81, 0x40, 0x01, 0xCO, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xCO, 0x80, 0x41,
0x01, 0xCO, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xCO, 0x80, 0x41, 0x00, OxC1, 0x81, 0x40, 0x00, OxC1, 0x81, 0x40,
0x01, 0xCO, 0x80, 0x41, 0x01, 0xCO, 0x80, 0x41, 0x00, OxC1, 0x81, 0x40, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xCO, 0x80, 0x41,
0x00, 0xC1, 0x81, 0x40, 0x01, 0xCO, 0x80, 0x41, 0x01, 0xCO, 0x80, 0x41, 0x00, OxC1, 0x81, 0x40

}

— Low-Order Byte Table

/* Table of CRC values for low—order byte */

static char auchCRCLo[] = {

0x00, 0xCO, 0xC1, 0x01, 0xC3, 0x03, 0x02, 0xC2, 0xC6, 0x06, 0x07, 0xC7, 0x05, 0xC5, 0xC4, 0x04, 0xCC, 0x0C, 0xOD, OxCD,
OxOF, OxCF, OxCE, OxOE, OxOA, OxCA, 0xCB, 0x0B, 0xC9, 0x09, 0x08, 0xC8, 0xD8, 0x18, 0x19, 0xD9, 0x1B, OxDB, OxDA, Ox1A,
Ox1E, OxDE, OxDF, Ox1F, OxDD, 0x1D, 0x1C, OxDC, Ox14, 0xD4, 0xD5, 0x15, 0xD7, 0x17, 0x16, 0xD6, 0xD2, 0x12, 0x13, 0xD3,
0x11, 0xD1, 0xDO, 0x10, OxFO, 0x30, 0x31, OxF1, 0x33, OxF3, OxF2, 0x32, 0x36, OxF6, OxF7, 0x37, OxF5, 0x35, 0x34, OxF4,
0x3C, OxFC, OxFD, 0x3D, OxFF, Ox3F, Ox3E, OxFE, OxFA, Ox3A, 0x3B, OxFB, 0x39, OxF9, OxF8, 0x38, 0x28, OxE8, OxE9, 0x29,
OxEB, 0x2B, Ox2A, OxEA, OxEE, Ox2E, Ox2F, OxEF, 0x2D, OxED, OxEC, 0x2C, OxE4, 0x24, 0x25, OxE5, 0x27, OxE7, OxE6, 0x26,
0x22, OxE2, OxE3, 0x23, OxE1, 0x21, 0x20, OxEO, OxAO, 0x60, 0x61, OxA1, 0x63, O0xA3, 0xA2, 0x62, 0x66, OxA6, OxA7, Ox67,
0xA5, 0x65, 0x64, 0xA4, 0x6C, OxAC, OxAD, 0x6D, OxAF, Ox6F, Ox6E, OxAE, OxAA, Ox6A, 0x6B, OxAB, 0x69, 0xA9, 0xA8, 0x68,
0x78, 0xB8, 0xB9, 0x79, OxBB, 0x7B, Ox7A, OxBA, OxBE, Ox7E, Ox7F, OxBF, Ox7D, OxBD, OxBC, 0x7C, OxB4, 0x74, 0x75, O0xB5,
0x77, 0xB7, 0xB6, 0x76, 0x72, 0xB2, 0xB3, 0x73, 0xB1, 0x71, 0x70, 0xBO, 0x50, 0x90, 0x91, 0x51, 0x93, 0x53, 0x52, 0x92,
0x96, 0x56, 0x57, 0x97, 0x55, 0x95, 0x94, 0x54, 0x9C, 0x5C, 0x5D, 0x9D, Ox5F, Ox9F, Ox9E, Ox5E, Ox5A, 0x9A, 0x9B, O0x5B,
0x99, 0x59, 0x58, 0x98, 0x88, 0x48, 0x49, 0x89, 0x4B, 0x8B, Ox8A, Ox4A, Ox4E, Ox8E, Ox8F, Ox4F, 0x8D, 0x4D, 0x4C, 0x8C,
0x44, 0x84, 0x85, 0x45, 0x87, 0x47, 0x46, 0x86, 0x82, 0x42, 0x43, 0x83, 0x41, 0x81, 0x80, 0x40

b
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